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Introduction
Setting up a website with WordPress is now easier than ever. In fact, you can have a 

blog or a small business site up in a matter of hours, even if this is your first time 

launching a project online.

In this eBook, we’ll introduce you to all the basic terms and steps you need to get the 

job done:

We’re going to cover every task involved in the journey. By the time we’re 

done, you’ll have a fully-functioning website you can use for any purpose. 

Selecting a hosting provider and a plan.

Registering a domain name.

Installing WordPress.

Navigating the WordPress dashboard like a pro.

Choosing the perfect theme.

Customizing your website’s appearance further.

Setting up your plugins.

Publishing content.

1.  

2.

3.

4.

5.

6.

7.

8.
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Launching your first website is fairly straightforward. Hosting has never been more affordable, and 
there are many platforms, such as WordPress, that make the process even more simple.

Before you jump in, however, you need to understand some basic concepts related to creating and 
managing a website. That way, you won’t be lost throughout the rest of this eBook.

In this chapter, we’re going to introduce you to seven terms that are critical to understanding 
modern websites, and ones built with WordPress in particular.

Below, we’ve defined seven common terms related to WordPress and websites in general. You’ll 
need to know them to carry out the steps in later chapters, so take your time and familiarize 
yourself with them.

7 Helpful Terms for Understanding WordPress Websites

Every website requires a server – a computer configured for public access through the internet. 
You have to store your website on one to make it available to users online. 

A web host or hosting provider is a company that offers servers you can rent to store your 
website. You’ll pay a monthly fee for this service.

The hosting price depends on the plan you sign up for, which generally determines how powerful 
your server is. We’ll discuss this in more detail in Chapter 2.

1.   Hosting

https://www.hostinger.com/tutorials/what-is-web-hosting/?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/wordpress-hosting?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/wordpress-hosting?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
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A CMS is a type of platform that enables you to build websites and organize online content. 
WordPress is the most popular example:

With a CMS, you can build a robust website without coding. Even experienced web developers 
often use them to save time and make their jobs easier.

3.   Content Management System (CMS)

To access a website, you type its domain name into your browser:

2.   Domain Name

To acquire an address for your own site, you’ll have to register it, which involves:

Thanks to domains, we can reach websites easily. Without them, you would have to enter an IP 
address instead, which is much harder to remember. 

Your domain also becomes a key part of your brand, so it’s important to choose a name that is 
related to your company or project. We recommend keeping it short, simple, and easy to spell. 

1. Checking if your desired domain is available.
2. Paying a fee to a domain registrar.
3. Renewing your registration regularly.

https://www.hostinger.com/tutorials/what-is-a-domain-name#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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There are a lot of different types of CMSs to pick from. You have options for eCommerce, forums, 
social media platforms, and many other types of projects. While WordPress was initially created as 
a blogging platform, it is highly versatile. Thanks to various plugins, you can create virtually any kind 
of website with the platform.

WordPress has a back-end interface or dashboard for managing your website’s content, settings, 
and other key elements. It’s only visible to you and other authorized users, not the general public:

4.   WordPress Dashboard

The vast majority of changes you make to your website take place here, and there are a lot of 
options to take note of. In the upcoming chapters, we’ll teach you how to navigate and use your  
WordPress dashboard.

Plugins are add-ons that extend the functionality of WordPress. There are tens of thousands of 
them available online. If you can imagine a feature, there’s probably a plugin out there that can help 
you implement it.

5.   Plugins

There are many plugins available for free, as well as premium tools that typically include more 
powerful features and customization options. You can download a large majority of what you’ll 
need for a small site at no cost.

https://www.hostinger.com/tutorials/what-is-a-cms/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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WordPress themes are templates for your website’s style. Just as with plugins, you have thousands 
to choose from. While some are absolutely free, others might charge a few hundred for a license.

6.   Themes

Depending on which theme you use, you’ll gain access to unique features, customization options, 
and more. Some even include pre-built layouts and website designs you can use in case you don’t 
want to start from scratch.

WordPress divides content into two main categories: pages and posts. Pages are for static 
content, such as your Homepage or About page. 

Posts are more timely. Their name refers to blog posts, which illustrate their function well. However, 
you can adapt them to various purposes:

This is a simple distinction WordPress makes to help you organize your website’s content. The CMS 
also supports what is referred to as custom post types, which can be anything from online store 
products to reviews, depending on how you set up your website.

7.   Posts and Pages
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With an abundance of offered features, different plans, and varying pricing models, it can be hard 
to find the most suitable hosting provider for your needs.

Knowing what to search for in a reputable hosting provider will save you a lot of time and effort. 
Once you’ve chosen a web host, selecting a plan also becomes much easier.

In this chapter, we’ll help you make those critical decisions. We’ll discuss what sets the best web 
hosts apart and how to spot them. Then we’ll explain how to pick the perfect plan for your new site. 

In Chapter 1, we explained what web hosting is. However, we didn’t get the opportunity to talk 
about the types of hosting and their differences. With that in mind, here are the most common 
options you’ll see available:

There might be more types of hosting available depending on your provider. However, for the rest 
of this eBook, we’ll focus on Hostinger’s WordPress hosting solutions since they include a lot of 
features that will make setting up your website easier.

Introduction to Web Hosting

Selecting a host is a serious commitment, so it’s wise to be picky. If everything goes well, you’re 
going to be in a long-term relationship with this company. Here are some positive indicators to 
look for:

What to Look for in a Hosting Provider

WordPress hosting. This service is custom-built for WordPress users and 
includes tools and services to make managing your site easier. At Hostinger, all 
of our plans are WordPress-optimized for your convenience.

Shared hosting. With this type of plan, multiple users share one server. This 
keeps prices low, but your site might crash if another one on the server 
experiences a sudden spike of traffic.

Virtual Private Servers (VPS). With a VPS, you still share a physical server, but 
you get dedicated resources for better performance and a higher degree of 
customization.

Cloud hosting. While it is more expensive than shared hosting, cloud hosting 
uses a network of servers to ensure better performance and higher availability.

https://www.hostinger.com/wordpress-hosting?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website


Three. Two. OnlineHOSTINGER

Chapter 2 Selecting a Hosting Provider and a Plan 10

- The company has plenty of five-star reviews.
- You can choose from a range of plans depending on your budget and website size.
- The host offers excellent customer support with 24/7 availability.

These days, finding WordPress hosting at low prices, such as $5 per month or less, is fairly easy. 
You can be selective even if you don’t have a huge budget. Hostinger, for example, offers some of 
the most inexpensive plans on the market, while still being rated consistently as a top provider.

Below, we’ll show you how to sign up for our most popular WordPress hosting solution – Business 
Web Hosting plan. However, the process works much the same for every company and package. 
You should be able to follow these steps even if you choose another solution.

How to Sign Up for a WordPress Hosting Plan
With Hostinger (In 2 Steps)

Before you do anything else, you must decide which hosting plan you want and add it to your cart. 
Most providers will enable you to choose from multiple tiers:

Generally speaking, the more expensive the plan, the more storage and power it provides. However, 
it’s always wise to read the fine print so you know what you’re getting into. Once you make a 
decision, proceed to the checkout stage. 

1.   Purchase a WordPress Hosting Plan

https://www.hostinger.com/?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/wordpress-hosting?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/wordpress-hosting?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website


Most hosting providers, including us, will give you massive discounts for longer-term contracts. You 
can save a lot of money this way, even if it means a higher payment upfront.

Furthermore, this plan comes with a free domain for 1st year, so you won’t have to buy a domain 
separately, but let’s save that for Chapter 3.

While completing the checkout process, you’ll be asked to provide an email address and password 
for your account. Make sure to store them somewhere safe.

Here, you usually have a choice regarding the contract length you want to sign up for:
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After completing your purchase, you can log into your hosting control panel. To do this, use the 
credentials you chose during the checkout process:

Once you’re in, you’ll see an overview of all your Hostinger products, including the plan you just 
purchased. Notice the Setup button next to it – this means you still have to configure the plan 
before you can use it.

To do so, however, you need a domain name. Let’s take care of that before we dive into installing 
WordPress.

2.   Access Your Hosting Control Panel

https://www.hostinger.com/tutorials/video/how-to-buy-a-domain-name-at-hostinger#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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Once you have a hosting plan, you only need one more thing before you can start working on your 
website, and that’s a domain.

Many web hosts also enable you to register domains as you purchase a plan. Hostinger is one of 
them. With us, you can register yours for as little as $1, depending on which Top-Level Domain 
(TLD) you want to use. A .com address, for example, is a bit more expensive.

Remember that if you opt for a plan of 12 months or longer with us, you will get a domain name 
completely for free.

In this chapter, we're going to show you how to register a domain name through Hostinger. It's quite 
simple, so let's get to it.

Registering a domain is usually pretty easy, regardless of which web host or registrar you use. 
However, purchasing a domain through your hosting provider often makes the process of setting 
up your site easier. With that in mind, here’s how to do so with Hostinger.

How to Register a Domain With Hostinger (In 2 Steps)

With Hostinger, you can look up available domain names by selecting the Domain option on our 
homepage:

On the next page, enter the domain name you want to use, then click on Search.

1.   Choose Your Domain Name

https://www.hostinger.com/tutorials/what-is-tld?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/tutorials/what-is-tld?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/tutorials/video/how-to-buy-a-domain-name-at-hostinger#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/domain-checker#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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If the option you entered isn’t available, we’ll give you plenty of alternatives to consider:

At this stage, we recommend you take your time until you find a domain you’re happy with. As the 
address visitors will use to access your website, it’s an important part of your overall brand and 
image. It’s best not to rush through this decision. 

Use  HostingerTutorials  discount code
and get an additional 10% off for
WordPress hosting plans

 

Use It Today

%
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Once you settle on one, add your domain to your cart and proceed to the checkout page:

Domain registration costs can vary depending on several factors, including:

- Checking if your desired domain is available.
- Paying a fee to a domain registrar.
- Renewing your registration regularly.

During the checkout process, you’ll have the option to choose the duration of your initial domain 
registration. A longer contract means you won’t have to worry about renewing it for a while, but the 
choice is ultimately up to you.

At this stage, you can also opt to include some extras. For example, you may choose to hide 
personal information about your domain from the public.

When you’re ready, proceed with the payment process. Once the domain belongs to you, you’ll find 
it listed in the Domains section on your hosting control panel, hPanel:

Now all that’s left is to connect your domain to your hosting plan. We’re going to cover that in the 
next chapter and install WordPress while we’re at it.

2.   Purchase Your Initial Registration
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Now that you have both a domain and a hosting account, it’s time to install WordPress. There are 
several ways you can do so, depending on your web host. 

Ideally, your web host will offer you the option to install WordPress with a few clicks. That way, you 
can get your website up and running faster.

For this chapter, we’re going to show you how to install WordPress on your Hostinger account, 
which shouldn’t take more than a few minutes.

When you log into your Hostinger dashboard now, you should see your domain listed alongside 
your hosting plan. We can install WordPress on your hosting plan and point your domain toward 
your website in one go. The Hostinger website setup wizard makes it easy.

Keep in mind, however, that not all web hosts offer comparable features. If your provider 
doesn’t, you may have to install WordPress manually. It’s not too difficult, but it does require 
some technical skills.

How to Install WordPress on Your Hostinger Account

To get started with Hostinger, go to the Hosting section on your hPanel, and click on the Setup 
button to the right of your hosting plan in your control panel.

On the next screen, click on Start Now. You will be asked what website type you want to create.

Run the Auto-Installer

https://www.hostinger.com/tutorials/how-to-install-wordpress-in-3-steps/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://wordpress.org/support/article/how-to-install-wordpress/
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Once you choose the type, you will have to say whether you are creating a new site or migrating one. 

Let’s Select the Create a new website option. Then, choose WordPress as your platform.

You will be directed to the window asking to create your login details for the WordPress account. 
Make sure to memorize them. 
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Then, to make your WordPress journey easier, we will offer some of the best WordPress 
plugins to install:

Once done, choose your preferred WordPress theme. As we’ll help you pick the perfect theme for 
your site and customize it later, feel free to skip this for now. 

https://www.hostinger.com/tutorials/best-wordpress-plugins?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/tutorials/best-wordpress-plugins?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
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With Hostinger, you can also automate your text creation with AI. Just enter at least 10 
characters, and the tool will create a few WordPress posts for you.

Finally, click on Use an Existing Domain to select the one you registered in Chapter 3. Since it’s 
already configured to work with Hostinger, you don’t have to do anything else – a key advantage of 
registering your domain with your hosting provider.
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Now the installer will take a few minutes to set up your website, so sit back and relax while it 
works its magic in the background. Once everything is done, you will see this:

If you registered your domain with a different registrar than Hostinger, you will have to access your 
domain settings on their control panel and point your domain to our nameservers. 

Once your website is ready and the DNS propagation period, which can take from 24-72 hours, is 
over, you’ll be able to jump to your WordPress Login page and continue customizing there.

On the other hand, if your domain is registered with us, you won’t need to take any further action.

https://www.hostinger.com/tutorials/how-to-point-domain-to-hostinger?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
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At this stage, your website is ready for customization. Since you’re using WordPress, that involves 
logging into your dashboard. Using it for the first time can be overwhelming, as it includes a lot of 
options.

However, once you learn the ins and outs of the dashboard, you’ll understand why WordPress is so 
popular. Everything you need to build a stylish and successful website is right at your fingertips.

In this chapter, we’re going to teach you how to access the back end of your website and walk you 
through each component of the WordPress dashboard. 

The back end of your website is where you can find all the options for customizing its looks, as well 
as publishing content. To access it, you first need to log in. You should be able to do so by typing 
yourwebsite.com/wp-login.php into your browser.

Then, enter the username or email address and password you set up when you installed WordPress:

Alternatively, if you’re using hPanel, you can access 
your WordPress admin area by navigating to the 
WordPress → Overview section.

How to Access and Navigate the WordPress Dashboard

https://www.hostinger.com/tutorials/wordpress/how-to-login-to-wordpress-dashboard#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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Once there, click on Edit Website.

Once you log in, you’ll see your dashboard’s main hub. It includes a lot of information, but there’s no 
need to feel overwhelmed. When you break the back end down into its major parts, it’s not difficult 
to understand at all. 

In our case, the WordPress dashboard presents new major changes in the WordPress 6.2.2 version. 

The dashboard also includes ten default tabs in the menu to the left. The one pictured above has 
additional ones – WPForms, Hostinger, and All-in-One WP Migration. These are plugins, which 
we’ll discuss in Chapter 8. Now, let’s focus on the standard ones.
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The first default tab is labeled Dashboard. It includes two subsections. The first is the Home 
screen, which is the main hub pictured above.

The second is the Updates screen. Here you can see any components of your WordPress site that 
are out of date:

A red icon will appear in the sidebar menu when something in this tab requires your attention. 
Keeping your WordPress installation, plugins, and themes up-to-date is an important security 
measure, so be sure to upgrade to new versions whenever you see a notification.

1.   Dashboard

The Posts tab provides a quick overview of all your blog posts. Here, you can see their publication 
status, comments, authors, categories, tags, and more: 

2.   Posts

https://www.hostinger.com/tutorials/video/wordpress-dashboard-walk-through-for-beginners#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website


Three. Two. OnlineHOSTINGER

Chapter 5 Navigating Through the WordPress Dashboard 26

For each post, there are four actions you can take:

- Edit. Using the WordPress editor, you can make extensive changes to its content as well as its 
metadata and taxonomies.

- Quick Edit. You can change the post’s status, title, slug, or taxonomies without having to enter 
the editor.

- Trash. Delete the post permanently.

- Preview. Check out how the post will look to visitors.

Using the Add New button at the top of the screen, you can draft and publish fresh content. The 
Bulk Actions dropdown enables you to select multiple posts to edit or trash simultaneously.

Here, you can view your Media Library. It includes all the image, video, audio, and PDF files you’ve 
uploaded to your website. If you click on one, you can edit its details and how it appears on your site:

You can use the Add New button to upload additional files.

3.   Media

The Pages tab works identically to the Posts screen:

4.   Pages
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Once again, you can edit, quick edit, trash, or preview your content. You can also add new pages or 
implement bulk actions. The only difference is that WordPress treats pages and posts differently, 
as we explained in Chapter 1.

If you enable comments for your website, you can see everything visitors are saying about your posts:

The Comments tab includes different sections for approved comments, spam, those pending 
moderation, and deleted submissions. By default, you’ll have to approve comments from all 
first-time posters here.

5.   Comments

In the Appearance tab, you can switch themes, customize them, or install new ones by clicking on 
the Add New button: 

6.   Appearance
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If you already have a theme, you can Customize it by clicking on the button. 

Other subsections are:

- Customize. Access the WordPress Customizer.

- Widgets. These are small content blocks that remain visible throughout your site, and are 
usually found in your sidebar or footer.

- Menus. Navigation links displayed in your header, footer, or sidebar to help users get around 
your site.

- Theme Editor. A built-in code editor that you’ll likely only use for major troubleshooting.

Most users can accomplish everything they need using the Customizer, which we’ll explore in more 
detail in a later chapter.

Plugins are a key part of the WordPress experience. Here, you can manage the ones installed 
on your website:

The Add New button enables you to install additional plugins by uploading a .zip file or searching 
the WordPress Plugin Directory.

7.   Plugins
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If you click on the Users tab at this point, there should only be one listed – you:

Once you add more users to your site, you can manage their accounts here. You’ll also be able to 
assign them roles, which will determine which parts of your dashboard they can access.

8.   Users

The Tools tab includes some default functionality that is primarily helpful if you’re migrating 
from another platform:

You can also import and export content as a CSV file or transfer it from another WordPress site.

9.   Tools
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Here you can edit your website’s primary settings, including your contact information, 
homepage, and whether users can register for accounts:

Keep in mind that we’re only scratching the surface of what WordPress has to offer. Each tab 
includes many options we don’t have time to cover in-depth here. However, now that you generally 
know your way around the WordPress dashboard, you can put aside some time to become more 
familiar with it.

10.   Settings
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From free to paid ones, there are thousands of WordPress themes. You have options to help you 
create almost any type of website, from an online portfolio to an eCommerce store. However, you’ll 
have to sift through them to find the best one for your needs.

Ideally, you should choose a theme you won’t need to replace for a long time. If you know the 
hallmarks of a quality option, that shouldn’t be an issue.

In this chapter, we’ll talk about all the things you need to consider when choosing a WordPress 
theme. Then we’ll show you how to install one so you can start customizing your website.

Picking the right WordPress theme isn’t just about the looks. A lot of them offer functionality that 
goes well beyond style. If you run an online store, for example, you can find one that will provide 
templates for your product, cart, and checkout pages.

For both multi-purpose and niche themes, you can find free and premium options. Paid themes 
aren’t necessarily better, but they usually offer more advanced features and dedicated support.

As for where you can find themes, WordPress enables you to browse its official repository of free 
options from your dashboard. Just navigate to Appearance → Themes.

How to Choose a Theme for Your WordPress Website
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From here, you can also install themes, which we’ll cover shortly. 

If you’re looking for premium options, you’ll want to try marketplaces such as Themeforest or 
Template Monster. Some developers also sell their products directly from their own websites.

Regardless of where you look for WordPress themes, consider the following tips for picking a 
quality option:

- Look for themes that receive regular updates from their developers.

- Check out as many reviews as you can and pay close attention to negative ones.

- Make sure the features the theme offers align with what you need.

- Look for options with thorough documentation or support that you can consult if you run into 
issues.

Once you find a theme that offers all those features and fits the aesthetic you want for your 
website, it’s time to install it.

https://www.hostinger.com/tutorials/wordpress/how-to-install-wordpress-themes
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Depending on whether you’re using a free or premium theme, there are two ways to install it on your 
WordPress site. Here’s how to get started.

How to Install a WordPress Theme on
Your Website (2 Possible Methods)

If you’re going to use a free theme from the official Repository, the easiest way to add it to your 
site is using the WordPress built-in installation feature. To get started, return to your dashboard 
and go to Appearance → Themes.

There, you’ll see a list of the themes WordPress installs on your site by default.

To install a new theme, you can click on the Add New Theme option seen in the screenshot above 
or on the Add New button at the top of the page. Once you do that, WordPress will enable you to 
browse the official Theme Repository. 

Method 1: Install a Free Theme from Your Dashboard

https://www.hostinger.com/tutorials/best-free-wordpress-themes/?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
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You can click on any theme to see more details, such as reviews and the last update date. Once 
you’ve made your selection, click on the Install button:
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After WordPress finishes installing your theme, this button will update to read Activate.

Click on the Activate button to apply your theme to your website.

If you choose a premium theme, you will get its .zip file after purchasing it. You can also download 
.zip files for free themes from the WordPress Repository:

Method 2: Upload Your Theme’s Files
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To install your theme using a .zip file, navigate to Appearance → Themes in your dashboard and 
click on the Add New button at the top of the screen. Instead of using the search functionality 
here, click on the Upload Theme button.

This will open the File Manager. Click on Choose File, select your theme’s .zip file from your 
computer, and click Install Now to add it to your site. WordPress will return a success message 
when the process is complete.

Click on the Activate link here to apply the theme to your website. 

After your theme’s installed, you can return to Appearance → Themes and find it listed as an 
available option.

https://www.hostinger.com/tutorials/how-to-use-hostinger-file-manager/?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
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You can switch to a different theme at any time by clicking on its Activate button on this screen. 

That’s it with selecting the theme – continue reading to find out how you can customize your site’s 
appearance further.
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Installing a theme is an excellent start. However, before your website is ready for the public, there 
may be certain elements you want to personalize. Plus, there are key features, such as your 
navigation menu, that you’ll need to attend to.

There are several ways to change your WordPress website’s appearance, but the easiest is to use 
the Customizer. With this tool, you can modify all the most important aspects of your site while 
previewing how it will look for visitors.

In this chapter, we’ll explain how you can use the WordPress Customizer to get your website 
looking pixel-perfect. Then we’ll go over three key areas of your site that you might want to edit. 

Themes enable you to completely overhaul your WordPress website’s style, but in most cases, you 
will need to make some changes to get things looking exactly the way you want. WordPress 
enables you to do this using a tool called the Customizer, which you can access by navigating to 
Appearance → Customize in your dashboard.

To the right, you can see a preview of your website, which you can navigate as usual by clicking on 
links. You can click on any blue pencil icon to edit the corresponding element.

The menu to the left includes all the style options you can play with, such as colors, background 
images, widgets, and more. Keep in mind that the options available here will depend on the theme 
you’re using.

Introduction to the WordPress Customizer
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Although the full list of customization options available to you will depend on your theme, there 
are a few that tend to come standard. These include Site Identity, Menus, and Widgets. Let’s 
take a look at each of them in turn.

3 Key Elements of Your WordPress Site to Edit
with the Customizer

First off, the Site Identity tab enables you to change your website’s title and tagline, as well as 
modify its icon.

You’ll also likely have the option to upload a logo or header image. Essentially, this tab contains the 
core elements that make up the visual identity of a brand.

Whether you’re running a blog or a small business site, branding is important to building your 
website’s audience. That makes this a crucial step when you’re putting the finishing touches on 
your site’s look.

1.   Build Your Site Identity

If you navigate to the Widgets tab, you can add or remove WordPress widgets from your site’s 
footer or sidebar. These are pre-built elements you can place in permanent spots across your 
website, so they’ll be visible on every page.

Some examples of widgets include search bars, Recent Posts sections, post Archives, and more. 
Several themes also come with their own unique widgets, especially if you choose a niche option 
over a multi-purpose style.

To sum up, your widgets will depend on your chosen theme, but worry not – every theme has 
options for them.

2.   Incorporate Widgets to Highlight Important Content

https://www.hostinger.com/tutorials/wordpress-widgets#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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Widgets can be especially useful for highlighting key content since every visitor will see them. You 
may want to include your email subscription form, social media links, or other opportunities for 
engagement to build your audience.

Menus are an essential component of any website because they enable your visitors to easily 
jump between pages. While many of the features in the Customizer are optional depending on your 
personal preferences, a navigation menu is a must.

As with widgets, the exact menu locations will depend on your chosen theme.

To start building yours, click on Menus → Main Menu

3.   Improve Navigation With a Custom Menu

https://www.hostinger.com/tutorials/wordpress-menu-plugins/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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WordPress enables you to add internal pages, posts, categories, tags, and external links to your 
menus. In most cases, however, you’ll only add links to static pages such as your Homepage, About 
page, Contact information, and any other essential content.

Right now, there aren’t any pages on your website. If there were, you’d see a list of them appear 
under the Pages tab. You can click on the plus sign next to each title to add that link to your menu.

Make sure to click on the Publish button when you’re done to add your menu to your site. Its 
location will depend on your theme, but most primary menus appear in the header or the sidebar.

Now that your site’s appearance is taken care of, it’s time to consider what key functionality you 
need it to provide. That’s where the other WordPress extensions come into play.

Then, click on Create New Menu, add its name and choose appropriate locations, and select Next 
to add links to your menu:

https://www.hostinger.com/tutorials/video/how-to-create-a-homepage-in-your-wordpress-website-using-elementor#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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The number of WordPress themes you can choose from is massive, but it’s nothing compared to 
how many plugins are available. There are over 60,000 you can download from WordPress.org right 
now, and those are just the free ones.

Whether you’re using free or premium plugins, it’s important to know how to spot quality tools. With 
the right ones, you can completely overhaul your website’s functionality and gain access to any 
feature you can think of.

In this chapter, we’ll talk about how to spot the best plugins and go over some suggestions to get 
you started. Then we’ll show you how to install WordPress plugins, which only takes a minute or two.

Usually, you’ll turn to plugins when you want to implement a feature on your website that 
WordPress doesn’t include out of the box. Let’s say, for example, you want to add appointment 
booking functionality to your site. You can do so with a plugin.

Simply go to wordpress.org and type booking into the search bar. 

The same goes if you’re looking to set up a forum for your website, or any other kind of feature. With 
the right plugins, WordPress can become a social media platform, an online store, and much more. 

You can find both free and premium plugins available online. However, keep in mind that premium 
plugins aren’t necessarily better than their free counterparts. In many cases, free tools will do the 
trick, so we recommend you look into several options before paying for an expensive license.

However, not all WordPress plugins offer the same quality. In some cases, they can even have 
adverse effects on your website. Outdated tools may lower your site’s security, while others can 
slow it down or conflict with each other and cause errors.

Introduction to WordPress Plugins

https://www.hostinger.com/tutorials/what-is-wordpress-plugin?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/tutorials/wordpress/how-to-install-wordpress-plugins#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/wordpress-social-media#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/wordpress-ecommerce#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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It’s difficult to get the full picture of a plugin’s quality before you install it. However, you can follow a 
few recommendations to gauge whether a plugin is safe and worth your time. Ideally, it should:

- Receive regular updates and be compatible with the latest version of WordPress.

- Provide thorough documentation so you won’t have to spend hours trying to configure it.\

- Have mostly positive reviews.

It’s also wise to take a look at any negative feedback to see if other users have encountered 
serious issues.

If those criteria look familiar, it’s because we discussed a similar method for judging themes a 
couple of chapters ago. With plugins, however, the stakes tend to be higher. Every WordPress 
website uses a single active theme, but you can have dozens of plugins working at a time. 

Some of the most common plugin types you may want to consider include:

Most websites can benefit from these plugins. However, as always, we recommend you assess your 
site’s needs before making any decisions. There are also many niche tools you may want to 
consider depending on what type of site you’re building.

How to Choose Which WordPress Plugins to Use

SEO plugins. These tools provide suggestions to improve your site’s position on 

search engine result pages (SERPs). The top options here include Yoast SEO and 

The SEO Framework.

Backup plugins. For backing up your website, we recommend using UpdraftPlus 

or BackWPup. These plugins can create copies of your site you can use to 

restore it if it becomes compromised.

Performance optimization plugins. Hostinger WordPress installations come 

with the LiteSpeed Cache plugin pre-installed, which can help you improve your 

site’s performance.

Security plugins. With these tools, you can implement automated malware 

scans and other measures for preventing cyber attacks. Popular options include 

Sucuri and Wordfence.

https://www.hostinger.com/tutorials/best-seo-plugins-wordpress#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/backup-wordpress
https://www.hostinger.com/tutorials/litespeed-website-optimization-tool/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/litespeed-website-optimization-tool/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/wordpress-security-plugins
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Once you land on a plugin you want to install on your website, there are two ways you can go 
about it. They should look familiar, as they’re basically identical to the methods for installing 
themes we covered earlier.

Click on the Install Now button next to the name of the plugin you want. WordPress will install it for 
you, and when it’s ready, the button will turn into a blue one that reads Activate.

Before you can start using a plugin, you need to activate it by clicking on the button. Just as with 
themes, you can have inactive plugins installed on your website, in case you don’t want to use 
them right away.

To activate a plugin later, navigate to Plugins → Installed Plugins.

How to Install a WordPress Plugin (2 Methods)

If the plugin you want to use is available in the WordPress Repository, you can look it up directly 
from your dashboard. To do so, go to Plugins → Add New and use the search bar at the top:

Method 1: Install a Free Plugin From Your Dashboard

https://www.hostinger.com/tutorials/wordpress/how-to-install-wordpress-plugins#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/wordpress/how-to-install-wordpress-plugins#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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Then click on the Activate link below its name.

Navigate to Plugins → Add New and click on the Upload Plugin button at the top of the page. Then 
click on Choose File locate the .zip file for the plugin you’re installing. Upload it, then click on the 
Install Now button:

Once the installation process is complete, you can activate the plugin right away or wait and do 
so later.

You can also upload plugin files manually. This is the method you’ll need to use to add premium plugins 
to your site. You should have the option to download a .zip file once you’ve paid for your license.

You can also download free plugins from the WordPress Repository.

Method 2: Upload Your Plugin’s Files
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At this point, you probably already have an idea of what pages you want your website to include. 
All that’s left is to build them. Doing so is relatively straightforward when using WordPress, thanks 
to the Gutenberg Block Editor.

With the Block Editor, you can design professional-looking pages using pre-built modules. You 
have blocks for paragraphs, images, tables, subheadings, and many more options. With the 
editor, you can place blocks anywhere you want and customize them to create unique pages.

In this final chapter, we’re going to show you how to build your first page in WordPress using the 
Block Editor.

Creating pages or posts in WordPress is similar from a technical standpoint since you always use 
the same editor. The primary differences are that posts have their own taxonomies, and pages 
tend to be more likely to include complex elements.

In any case, the first thing you want to do is set up a new page to work on, which you can do by 
navigating to Pages → Add New in your dashboard.

How to Publish Your First Page With WordPress (In 3 Steps)

Clicking on Add New will launch a blank canvas in the Block Editor. You can use the editor to set up 
and configure every aspect of your new pages and posts. The first thing you want to do is add a 
title to your new page.

If you click on the section that reads Type / to choose a block, a plus icon (+) will appear. Clicking 
on it it will show you the available blocks you can add to your page:

1.   Add Content Blocks

https://www.hostinger.com/tutorials/gutenberg-wordpress?utm_source=Hostinger+Tutorials+Email+EN&utm_medium=Mailchimp&utm_campaign=Ebook+How+to+build+website
https://www.hostinger.com/tutorials/wordpress-taxonomy/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
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Blocks are pre-built elements WordPress provides to help 
you build pages more efficiently. The most basic block is 
a paragraph, which lets you write and format segments of 
text. Once you add a block, if you select it, you can 
access additional customization options that vary from 
element to element:

Out of the box, the Block Editor includes a broad range of blocks, such as:

What’s more, depending on which plugins you use, you may gain access to additional blocks. When 
you put those elements together, you can build almost any type of page you need.

Once you have multiple blocks laid out, you can rearrange their order by clicking on the arrows 
within each element:

- Headings

- Tables

- Images and galleries

- Lists

- Quotes

- Audio and video !les

- Widgets
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The Block Editor also enables you to use columns to customize your designs even further. You 
can find the Columns block under the Layout Elements tab, alongside other options such as 
page breaks, separators, and spacers.

Creating pages boils down to adding the elements you want, arranging them in the right order, and 
customizing them until you’re happy with the results. However, there’s a lot more to pages than 
what meets the eye, which brings us to the next step.

Any time you use the Block Editor, this menu will appear on top:

Selecting the Settings option next to Publish will open a menu to the right, including all the 
important document options for your new page. These include its publication status, URL, featured 
image, discussion settings, and page attributes:

2.   Configure Your Document Options
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We’ll cover the Summary tab in the next step, so let’s 
jump right to the URL settings. Here you can customize 
the URL for the page you’re working on by clicking on it 
and modifying slug, which is at the end of the URL:

From the Discussion tab, you can choose whether 
or not to enable comments on this specific page. 
For pages, you usually want to keep comments 
disabled, unlike with posts:

You can also add a featured image to display at the 
top of the page. If you’re working on a post, it will also 
appear in your blog archives, usually as a thumbnail 
alongside the title:
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Finally, you have the Page Attributes section. 
Here, you can decide what page will be the 
parent page and in which order the remaining 
pages will be nested.

Keep in mind page attributes can vary depending on the theme you use. With some themes, you 
can also select a template for a page. 

Once you’ve configured all of those settings and your page’s content is to your liking, it’s time to 
talk about publishing it.

If you’re still working on a page and you 
want to save it to finish later, you can 
click on the Save Draft button at the 
top of the screen:

You can also take advantage of the Preview 
option to check out how your page will look 
from a visitor’s perspective at any time.

However, if you’re ready for it to go live, return 
to the Summary section under Settings. 
Under Visibility, you can set pages or posts 
to be Public, Private, or Password Protected. 
Anyone can see public pages, whereas 
private ones are only visible to you and the 
editors on your site:

3.   Publish Your Page or Post
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In most cases, you want pages to be public. 

If you’re ready for your page to go live right away, you can click on the Publish button once you 
select your page’s visibility. However, you can also schedule publication for a later date by 
clicking on Immediately next to Publish in the Document menu.

This will open a calendar where you can select the publication date and time:

Once you change the date to a point in the future, the Publish button will change to read 
Schedule. Click on it and confirm your choices. Your page should go live at the designated time.
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Once your website is ready, you get to decide what you want to do with it. You can set up 
corresponding social media accounts, engage with your visitors, sell products, and much more. 

Regardless of how you plan to use WordPress, there are thousands of guides and tutorials you can 
follow to make the website of your dreams. 

Conclusion
The process of launching a website is much easier than most might think, and with WordPress, you 
can be ready to receive your first online visitors in a matter of hours.

However, configuring and styling WordPress to work precisely the way you want is an ongoing 
process. If you want your website to endure, you need to update it continuously. That means 
publishing new content, doing the occasional redesign, keeping up with maintenance tasks, and 
much more.

For now, however, you’ve fulfilled your primary goal, which is to get your first site off the ground. 
Let’s recap the journey you just undertook:

Selecting a hosting provider and picking the right plan.

Registering a domain name.

Installing WordPress on your website.

Navigating through the WordPress dashboard.

Choosing the perfect theme for your website.

Customizing your website’s appearance.

Setting up any plugins you might need.

Publishing content on your website.

1.  

2.

3.

4.

5.

6.

7.

8.

https://www.hostinger.com/tutorials/wordpress-maintenance#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website
https://www.hostinger.com/tutorials/#utm_source=Hostinger%20Tutorials%20Email%20EN&utm_medium=Mailchimp&utm_campaign=Ebook%20How%20to%20build%20website



